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Chapter4
Performance Management 4

This chapter describes the CiscoWorks features that help you manage the performance level
of your network, including managing individual devices, lines, and interfaces.The chapter
describes how to do the following to monitor performance using CiscoWorks features:

■ Use Device Polling to create tables that poll the network for Management Information
Base (MIB) object data.

■ Use Polling Summary to view data for analysis.

■ Use the Real-Time Graphs to view real-time network information.

■ Use the Path Tool to display a routing path between devices and perform analysis on
that path.

■ Use Show Commands to monitor network information.

■ Write reports with the Sybase Data Workbench (DWB).

Performance Management Applications
Several CiscoWorks applications help manage the performance of the SNMP devices in
your network. A brief description of each application found in this chapter follows:

■ Device Polling—Probes and extracts data about the condition of your network devices.

■ Polling Summary—Views polling data, stops and starts polling.

■ Real-Time Graphs—Monitors the behavior of device interfaces or other network
elements suspected of operating in a degraded mode and displays them in a graph.

■ Path Tool—Graphically displays a route of the path from a source device to a destina-
tion device.

■ Show Commands—Provides data similar to router EXECshow commands output.

■ Sybase DWB—Allows you to access the Sybase Data Workbench application to write
reports.

These applications enhance your capabilities as a network administrator by collecting
network data as a baseline before your network develops problems. The applications are
discussed in detail in the following sections.

Figure 4-1 illustrates how to access the CiscoWorks applications from the SunNet Manager
(SNM) Tools menu. Figure 4-2 illustrates how to access CiscoWorks applications from the
SNM Glyphs Menu. The grayed-out tools are SNM tools.
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Figure 4-1 CiscoWorks Applications on the SNM Tools Menu
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Figure 4-2 CiscoWorks Applications on the SNM Glyphs Menu

Creating Polling Tables Using Device Polling
This section describes how to set up a customized polling table (or table group) for devices
and interfaces on the internetwork using Device Polling.

Device Polling Overview
CiscoWorks allows you to probe and extract information about the condition of your
networks using a polling feature. Information acquired from these polls is stored in the
database for further analysis. The construction and use of polling configurations allows you
to compare relative performance and status of devices and interfaces on the network. You
can poll devices individually, in groups, or poll all devices at once based on your disk space
availability. Multiple polls can be made to collect a wide range of data at varying polling
interval rates.

For consistency, this manual uses the termobject as a replacement for such terms as MIB
variable, MIB object instance, and so on. Other Cisco manuals may use different terms, but
they can be used interchangeably.

You must have security privileges to read and write to the Device Polling window. If you
do not have write privileges, you might not be able to apply or delete table changes. Use the
Privilege command on the Security menu to check your privileges for Device Polling. You
can use theChange User command to change to a username with such privileges.
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Device Polling Process
The polling process consists of the following general steps. Each task is described in greater
detail later in this chapter.

Step 1: Construct a table (or polling group) in Device Polling that contains the polling
configuration components. (When you complete construction of the table, press
Activate Changes to notify the polling daemon of these changes.)

Note: Activate Changes occurs automatically when you exit Device Polling using the
Quit  command on the File menu.

Step 2: Access the table in the Polling Summary and begin or end polling the devices
defined in the configuration (if you have not yet done so).

The MIB objects selected in the table are read by the polling table and written
to the database where they are retained for your use. Subsequent data polls do
not overwrite previous polled data. Data is stacked with all collected informa-
tion available for analysis.

Step 3: To browse poll data in a text or graph format, click on the data report and use the
Browse Data command.

This command sends the data report to the Results Browser.

Step 4: While browsing the data report, you can view text or convert the report to a
graph using the SNM Results Browser.

Figure 4-3 illustrates the device polling concept. The polling daemon used by CiscoWorks,
nmpolld, queries and stores information in the Sybase database. Both the Device Polling
and Polling Summary applications use the polling daemon.

Figure 4-3 Device Polling and Sybase Database Concept
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Device Polling Tables
A Device Polling table consists of the following elements: a polling interval, a set of MIB
objects, and a list of devices.The information specified in the table is collected during the
polling process. A collection of information from the polling process is called a data
segment. A segment is defined as the data selected from the start of polling to the stop of
polling, regardless of the interval used to sample. For instance, if you start polling at 1:00
p.m. and stop at 2:00 p.m. on the same day, the data segment will be contained in one hour
of polling. If you had set an interval of 1 minute, you would have obtained 60 samples in
the segment.

Figure 4-4 illustrates the configuration table construction concept. You can select MIB
objects to collect information on a device and choose a polling interval for the poll. The
polling interval has a significant impact on the amount of data collected in a given time
frame.

Figure 4-4 Polling Table Construction Concept

Note: Because the amount of data collected varies depending upon the type and number
of queries made, be sure to monitor the disk space available for storage of polled informa-
tion. Refer to the “Database Administration” chapter for additional information about
database and transaction log space.
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Running Multiple Pollers
The polling daemon (nmpolld) allows you to have multiple daemons running. You can have
any number of processes running on a single system or you can have processes running on
several systems.

The poller ID assigned to a polling group defines which poller process will perform the
polling for that poll group. Refer to the manual page for the specific rules.

The polling daemon on separate machines can be started or stopped by running the Process
Manager on the various machines. For example, you can run the Process Manager on one
workstation to start and stop a single polling daemon and at the same time run the Process
Manager on another workstation to start and stop a single polling daemon on that machine.
The Process Manager does not assist in starting or stopping multiple polling daemons on a
single machine.

The following are the two issues of starting and stopping:

■ Starting—The Process Manager will only start one polling daemon. To start more than
one polling daemon, you must do it manually, or you could add commands to the
/etc/rc.local so that the polling daemons could be started up everytime the workstation
comes up. CiscoWorks has already put one line inrc.local to start and stop the polling
daemon. You can copy and paste that line into the /etc/rc.local file in order to start a
second polling daemon.

■ Stopping—You can stop the polling daemons from the command line by issuing a
kill -TERM  command. You can also use the Process Manager, but we recommend you
use the command line method.

Note: Even though you have instructed the Process Manager to stop the polling daemon,
the Process Manager may still indicate the polling daemon is running. This does not neces-
sarily indicate that the Process Manager or the polling daemon is working improperly. It
may be due to multiple daemons.

Device Polling Window
Before you can begin polling devices for data, you must set up your polling table in the
Device Polling window.

Figure 4-5 illustrates the Device Polling window. Table 4-1 describes the components
found in this window.
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Figure 4-5 Device Polling Window
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Table 4-1 Device Polling Window Components

Component Subcomponent Description

File Print
Version

Quit

Prints a snapshot of the window.
Displays the CiscoWorks application version
information.
Exits the current window.

Options Activate Changes

Destroy Table

Sends a signal to the polling daemon to
reread the database so current changes are
included in the poll.
Deletes the selected polling table.

Security Change User
Privilege

Changes the user ID to another user.
Views the current user ID privileges.

Help Provides a manual page on the current win-
dow.

Poll Group Default=no polling Describes the table poll group name. For
example, CiscoWorks supplies an example
table namedsample.

Poll Rate Sets the polling interval for the last table
name selected. Polled data segments are date
and timestamped with start poll times.

Group All Devices
Device A—Device
?
Device ?—Device Z

Lists which devices you are choosing from.

Device Lists all devices currently in the device
group.

Poller ;0
others
Default=only one
daemon to poll
tables

Selects which systems will actually perform
the current poll.You can have multiple sys-
tems acting as polling engines.

Table Default=same as
poll group name

Describes the Sybase database table name of
the current poll. This name can be the same
as the poll group name.

Enterprise (first level) Lists the SNM enterprise MIB objects from
the SNM agent schema file.

Group (second level) Lists of related MIB groups from the speci-
fied enterprise group above.

Object (third level) Lists of MIB object names (also referred to
by Cisco as variables) from the specified
MIB group above. Objects applied here
define objects available in the group.
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Object Requirements
The Object field lists the MIB objects you can select to poll. MIB objects define the type of
information about devices and interfaces that will be collected with the poll.

When selecting objects, remember the following requirements:

■ For protocol-specific MIB objects, for example,xnsInput, you must have the corre-
sponding protocol enabled in the device. Otherwise, no data will be stored for the MIB
objects.

■ If you have modified your MIB database, ensure that the MIB objects you are polling
for still exist in the MIB database. Use theshowmibcommand to verify the existence
of the objects in the database. Refer to Appendix A, “MIB Files and Objects,” for
detailed information on themakemib and showmib commands, and a description of
the MIB database.

Disk Space Consumption Rate
As each object is selected, the Disk Consumption Rate field is adjusted to reflect an estimate
of how fast the disk space will be consumed in order to store the polled data. The algorithm
uses the poll rate, number of devices, and number of objects currently selected in the table
to estimate the space required to hold one day (24 hours) of polling. The result of the
calculation is reflected as whole kilobytes required per day.

Instance Pick menu for
if_tables instances

Describes the list of keys supplied by the
MIB object tables to poll. Only lists inter-
faces if you use the if_tables. Otherwise, the
pick menu will be empty and you must sup-
ply your own key for the MIB object
selected. If no interface is chosen, all inter-
faces (keys) will be polled. Only objects in a
table need or can have an instance.

Apply Applies current changes for this polling table
to the database. This does not notify the poll-
ing daemon. Use theActivate Changes
command to complete the polling setup.

Disk Con-
sumption
Rate

Describes the disk space growth rate (in kilo-
bytes per day) to hold the data for this type
of poll.

New Erases all information currently in the win-
dow. The form remains, ready to accept new
information. This command does not affect
data in the database.

Delete Erases the devices selected from the data-
base.

Component Subcomponent Description
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Multiply the disk space consumption rate by the length of time you plan to poll. This equals
the number you can compare to available disk space. If you do not want to change the
polling table, you might have to increase your database space allocation. Before deciding
to adjust disk space, review the polling interval and duration and the number of objects to
determine if any can be adjusted. To increase the database space, refer to the “Database
Administration” chapter for more information.

Creating a New Polling Table
In order to set up polling, access the Device Polling window and complete the necessary
information. If you are not familiar with MIB objects, using Device Polling will be more
difficult. Contact your network administrator for more information on MIB objects.

To access the Device Polling window to set up a new polling table, perform the following
steps:

Step 1: Select the Tools menu on the SNM console and pull down toDevice Polling.

The Device Polling window appears.

For a description of the device polling fields, refer to Table 4-1 earlier in this
chapter.

Step 2: Create a new poll group by selecting theNew button.

TheNew button clears the poll group data. You must press theNew button
before you enter new information.

Step 3: Create the new poll group name by entering the name in the Poll Group field.

Note: CiscoWorks is based on the Sybase SQL-based relational database. Poll group or
table names can include only the alphanumeric characters A through Z, 0 through 9, and
underscore ( _ ). A dot (.) is not allowed. For more information on naming tables, refer to
your Sybase manual set.

Only one poll group is used with each data configuration. The Poll Group field
defines what tables are in the poll groups.

CiscoWorks includes one example poll group table found under the pick menu,
calledsample. You can use this table and modify it to your specific polling
needs, but should rename the poll group to describe the type of polling you are
performing.

If you overwrite or delete thesample table, you can recreate it using the
makesample program. Themakesample program adds thesample file back to
your directory structure. Refer to the “Database Administration” chapter for in-
formation on themakesample program.
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Step 4: Create the new table name or use the poll group name as the table name by
default. To create a new table name, enter the name in the Table field.

Your poll group name and table name will default to the same name. You may
want to change the table name.

Note: You can only put in a table name prior to pressing the Apply button. After you press
Apply, the table is created and the table name cannot change.

Step 5: Select the poll rate for this poll. There are two methods of selecting a poll rate:

■ Select a default value from the Poll Rate pick menu pull down.

■ Enter a value directly in the Poll Rate field of the Device Polling window
and press Return. The poll rate recalculates after you pressApply.

Use seconds, minutes, days, or weeks as the unit of measure. If you enter 21 days
in the field, the data will be converted to 3 weeks, the largest unit of measure for
intervals that retains the integer entered.

Note: Be careful when selecting a poll interval since you need to watch your disk space
use.

Step 6: Select the Poller field and pull down the pick menu to one of the poller options.

The default is ;0. Refer to the manual page for Device Polling for a definition
of ;0.

Step 7: Select the Enterprise field and pull down the pick menu to one of the enterprise
MIB objects.

For example, if you are using thesample table, pull down tocisco.

Step 8: Select the Group field and pull down the pick menu to one of the MIB groups.
Select a MIB object.

For example, if you are using thesample table, pull down toifTraffic.

Step 9: Select the Object field and pull down the pick menu to one of the MIB objects
you want to include in this poll group.

For example, if you are using thesample table, pull down toifInOctets.

The Object field lists all MIB objects present in the SNM schema files. To select
multiple objects for the object poll group, click on theApply  button and then
select another object.

The objects selected apply to the last table name entered. If you want an object
to apply to a different table name, select the table first.

Step 10: If you have less than 60 devices in your device group, continue to the next step.
If you have more than 60 devices in your device group, select the Device Group
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field and pull down the pick menu to one of the listed device group options you
want to include in this poll.

By selecting a specific device group, your Device field list becomes more
defined. For example, if you choose the group of devices from X to Z, your
device list will include only those devices beginning with the letters X, Y, and Z.

Step 11: Select the Device field and pull down the pick menu to one of the devices you
want to include in this poll.

This list contains all devices in alphabetical order that are present in the
CiscoWorks database. To select multiple devices for this poll group, click on the
Apply  button and select another device.

Step 12: After you select the devices from the Device field, select the instances (interface
or key) associated with the device.

If you are using tables, for example if_tables, select the instance from the pick
menu. If you are not using if_tables, you must know the format of Sun MIB
object tables found in the schema file to enter the instance values. If you do not
know the format, skip the Instance field. This will cause the poll group to poll
all instances. Only objects in a table need or can have an instance. You can skip
this field if your object does not belong to an object table.

Step 13: When you click onApply, all data is sent to the database. The scroller windows
display what appears in the database. SelectActivate Changes from the Options
menu to send the changes to the device polling daemon.

Note: If you have chosen a poll rate, theActivate Changes command initiates the
polling daemon (nmpolld) to start polling this poll table.

This completes the process of creating a new polling table.

Adding Instance Data to an Existing Device and Object Pair
An instance defines which row to go to in a particular database table. The default instance
selection in Device Polling is to poll all objects on all devices. If you want to select specific
devices and MIB objects to limit your poll group, you need to add an instance to a device
and object pair.

When you want to add an instance to a device and object pair, you need to add the instance
in the Device Polling window.

To add an instance to a device and object pair, perform the following steps:

Step 1: Specify the device and object pair. To select a device and object pair, click on
the device name and then the object in the scroll windows.

Step 2: For if_tables, select an instance using the pick menu. For all other keys, you
need to enter the key manually. If you do not know your key, contact your
network administrator.
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Step 3: Click on theApply  button.

The new table with the instance added is now available for polling. The device
will now be polled for this specific object and specific instance. An “I” marks
the device and object pair you selected for polling. An asterisk (*) marks the
polled instance in the instance list.

Step 4: SelectActivate Changes from the Options menu to send the changes to the
polling daemon.

Step 5: Repeat steps 1 through 4 for each instance you want to add to a device and object
pair.

Note: When troubleshooting the Device Polling daemon, nmpolld, and the dataserver is
up, access the Log Manager’s centralized log. Check the log messages for a message that
nmpolld was reinitialized after Sybase restarted.

Modifying an Existing Poll Group Table
Device polling has the following limitations:

■ You cannot delete an object that already exists.

■ You cannot change an existing poll group or table name.

To delete an object, you have to delete the poll group and start again.

To modify an existing poll group table effectively, perform the following steps:

Step 1: Select the Poll Group pick menu and pull down to select the poll group name.

When an existing table name is selected, the configuration displays in the
window. If you have selected the table to change a data element, such as the
polling interval, perform the necessary changes.

Step 2: Save your changes to the database by clicking on theApply  button.

Step 3: Notify the polling daemon (nmpolld) of changes by selecting the Options menu
and pull down toActivate Changes.

If you do not perform this step, any changes you have made are unknown to
nmpolld and cannot be polled for.

Step 4: To switch from one table to another in the Device Polling window, pull down the
Poll Group selection and select a new table.
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Deleting a Poll Group Table
When you have finished with a poll group and want to remove it from the database, you
need to delete it from the Device Polling window.

To delete a poll group, perform the following steps:

Step 1: To select the poll group you want to delete, pull down on the pick menu to the
poll group name.

Step 2: Select the Edit menu and pull down toDestroy Table.

A confirmation window appears asking you to confirm the deletion. Answer
accordingly.

Step 3: Notify the polling daemon (nmpolld) of changes by selecting the Options menu
and pulling down toActivate Changes.

The Poll Group is now deleted from the Polling Summary table and the database.

Deleting a Device from a Poll Group
When you want to delete a particular device from a poll group, you need to delete the device
from the Device Polling window.

To delete a device from a poll group, perform the following steps:

Step 1: Select the poll group you want to change by pulling down on the pick menu to
the poll group name.

Step 2: Select the device in the Devices scroller.

Step 3: Click on theDelete button.

The new table with the device removed is now available for polling.

Step 4: Notify the polling daemon (nmpolld) of changes by selecting the Options menu
and pull down toActivate Changes.

The device is now deleted from the poll group.

Deleting Instance Data from a Poll Group Table
When you want to delete a particular instance from a poll group, you need to delete the
instance from the Device Polling window.

To delete an instance from a poll group, perform the following steps:

Step 1: To select a device and object pair, click on the device name and then the object
in the scroll windows.

Step 2: To select an instance, pull down the pick menu in the Instance field and select
the instance marked with an asterisk (*) you want to delete.
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Step 3: Click on theDelete button.

The new table with the instance removed is now available for polling.

Step 4: Repeat steps 1 through 3 for each instance you want to delete from the device
polling group.

Quitting Device Polling
When you exit a Device Polling window, any newly created polling tables with the poll rate
intervals set will begin polling automatically. If you do not want tables to begin polling, do
not enter the polling interval rate. The polling rate can be entered from the Polling Summary
window when you are ready to start polling.

To exit Device Polling, select the File menu and pull down to theQuit  command.

Using Polling Summary
Once you create your table using Device Polling, you can use the Polling Summary
application to browse data and stop or start polling. You can also delete tables from the
Polling Summary window.

Polling Summary Window
The Polling Summary window is the interface to stop, start, and browse poll data.

Figure 4-6 illustrates the Polling Summary window. Table 4-2 describes the components
found in this window.
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Figure 4-6 Polling Summary Window
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Table 4-2 Polling Summary Window Components

Starting or Stopping Your Poll Tables
After you have set your polling criteria with the Device Polling application, you can access
thePolling Summary application to turn polling off, start additional polling tables, or view
poll data. The Polling Summary application enables you to start and stop polling, browse
polling group data in the SNM Results Browser, and delete polling tables.

From the SNM Results Browser, you can use the SNM Grapher to graph your collected poll
data. Refer to the section on “Examining Polling Data.”

Component Subcomponent Description

File Print
Version

Quit

Prints a snapshot of the window.
Displays the CiscoWorks version information
for this application.
Exits the current window.

Options Activate Changes

Browse Data

Destroy Table

Signals the device polling daemon to reread
the database to get polling changes.
Uses SNM Browser to view selected data
reports or to graph data using Grapher.
Deletes the selected polling group.

Security Change User
Privilege

Changes your user ID to another user.
Views the current user ID privileges.

Help Provides a manual page on the current win-
dow.

Poll Rate 1 second
5 seconds
...
1 week
...
No polling

Starts and stops the polling process. Sets the
polling time interval for the last table name
selected. Any change is reflected in the data-
base.

Disk Consumption
Rate

Describes the disk growth rate required (in
kilobytes per day) to hold the data for this
type of poll.

Poll Groups scrol-
ler

Lists the poll groups available with the
Device Polling window. These are also
known as tables.

Objects scroller Lists MIB objects defined in Device Polling.

Devices scroller Lists all devices in the poll group defined in
Device Polling. You may need to use
Sync w/Sybase to locate new devices.

Data scroller Lists data reports that contain poll report
data. Includes the start time and length of poll
interval for the data report.
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To start or stop polling your poll group table, perform the following steps:

Step 1: Select the Tools menu on the SNM console and pull down to Polling Summary.

The Polling Summary window appears. See Figure 4-6.

Step 2: Select a group you want to poll from the Poll Groups scroll window in the
Polling Summary window.

Step 3: Select a polling rate if the table is not being polled currently. Then select the
Options menu and pull down to theActivate Changescommand.

The polling daemon (nmpolld) starts polling your devices in the background
based on your entries in the Device Polling window. You can continue to work
with the Device Polling window.

If your table is currently being polled, continue to the next step.

Step 4:  When you have collected the necessary data, stop the polling activity on this
group. To stop polling, select the poll rate pick menu and pull down toNo
Polling.

Step 5: Select the Options menu and pull down toActivate Changes or exit the Polling
Summary window.

Either of these choices will signal the polling daemon to stop polling.

Caution: If you do not stop a polling group process, you will increase your disk space
and lose useful information. Remember to use theNo Polling command in the Poll Rate
pick menu and theActivate Changes command from the Options menu.

Examining Polling Data
After you have completed your polling activity, you can examine your data in text or graph
form. Data is retrieved from the polled information segments obtained in polling
operations.

With the SNM Results Browser and Grapher features, you can review your data report
information. You can browse text information using the Results Browser. From the Results
Browser, you can send data to the SNM Grapher.

For example, you can compare input broadcast packets against the total number of input
packets to identify broadcast storms, as well as review and analyze interface performance
or traffic patterns by observing in and out packets over specific periods.

Refer to your SNM manuals for more information on using the Results Browser and
Grapher features.
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To view your polling data, perform the following steps:

Step 1: Select a poll group.

Selecting a poll group updates the devices and interfaces in the Devices scroll
window that will be available and, in turn, data segments that can be viewed or
graphed. A graph can consist of multiple segment columns and multiple devices.

For example, CiscoWorks ships asample table with the Device Polling applica-
tion. Click on thesampletable.

Note: Group selection triggers access to data contained in Devices and Variables
browsers. Prior to group selection, any attempts to obtain information from these browsers
are ignored. If a group name you want is not present, either it has not been created, has been
created but was never active, or has not completed a polling segment. Use the Device
Polling window in the Device Polling application to verify the existence of the group.

Step 2: To modify the poll rate interval, click on the pick menu and pull down to your
desired poll rate, or type the poll rate in the field and press Return.

Step 3: To view the data collected in your poll, from the Polling Summary window click
on the data report in the Data scroller.

Step 4: Select the Options menu and pull down toBrowse Data.

The SNM Results Browser window appears with the data report (also known as
the data stream in SNM) listed in the scroller. Refer to theSunNet Manager 2.0
Reference Guide for more information on the Results Browser.

Step 5: To view the text of the data report, click on the report name.

The data report text appears in the lower portion of the results browser.

Step 6: To view the data report in a graph format, click on the report name and select
Graph from the popup menu. Continue to pull theGraph menu to the right and
pull down to the specific graphing options you desire.

For this exercise, pull down toAll Attributes . An SNM Grapher window
appears with the data report name in the scroller. Seconds later, a graph appears.

Note: Although multiple graphs can be viewed simultaneously, initially only one poll
group can be used with one Grapher window. Refer to theSunNet Manager 2.0 Reference
Guidefor more detailed window information, such as on table data into one graph or
altering graph properties.

Step 7: To change the properties on your graph, return to the Results Grapher window,
select the report name and click on theProperties button. See Figure 4-7.

For more detailed information on customizing the SNM Graph Properties window, refer to
yourSunNet Manager 2.0 Reference Guide.
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Figure 4-7 SNM Graph Properties Window

Calculating Traffic Values on Serial Lines
Because serial lines are full duplex, there is no single way to perform a traffic calculation.
The following calculation provides the best view:

traffic = max(ifInOctets, ifOutOctets)
utilization = traffic/line bandwidth

In general, however, it is often less complex and more direct to look at traffic as the amount
of data transmitted by a given device onto a line. This is consistent with the router
calculation that obtains a load value.  In this case, use the following calculation (where the
utilization is a function of which end of the serial line that you are measuring):

traffic = ifOutOctets
utilization = traffic/line bandwidth
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If you useifInOctets+ifOutOctets as a traffic measure for serial lines, your utilization levels
appear to be greater than 100 percent.

To determine whether you have a serial line, check the interface_type column in the
Interfaces table. Table 4-3 lists the serial interface types and the protocols associated with
each interface. For detailed information on interfaces and protocols, refer to RFC 1213,
Management Information Base for Network Management of TCP/IP-based Internets: MIB-
II .

Table 4-3 Serial Interface and Protocol Type

To select serial interfaces, use the following with the WHERE clause:

select ...
where ...
and interfaces.interface_type in (2,3,4,5,16,17,18,19,20,21,22,23)

Serial
Interface
 Type

Protocol
Type

2 1822

3 1822

4 ddnx25

5 RFC 877-x25

16 lapb

17 sdlc

18 ds1

19 e1

20 ISDN

22 serial

23 PPP
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Using the Real-Time Graphs
When you use the Real-Time Graphs application to manage the performance of your
network, you can observe real-time information via a two- or three-dimensional
graph.CiscoWorks enables you to graph data about your router health and interface and
traffic information.

Real-Time Graphs Window
Figure 4-8 illustrates the Real-Time Graphs window. Table 4-4 describes the components
in this window. Table 4-5, Table 4-6, and Table 4-7 describe the buttons in the major fields.

Figure 4-8 Real-Time Graphs Window
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Table 4-4 Real-Time Graphs Window Components

Graphing Your Real-Time Device Data
The Real-Time Graphs application observes the behavior of devices suspected of being
degraded mode or introducing erratic behavior in traffic patterns, error status indications, or
statistics.

The Real-Time Graphs application monitors and graphs a single device. You can monitor
multiple devices simultaneously by opening more than one Grapher. In addition, you can
merge graphs to present the data in one graph.

Since the Real-Time Graphs application uses the SNM graphing utility, documentation on
customizing your graph can be found in the SunNet Manager 2.0 User’s Guide.

To create a graph with real-time device data, perform the following steps:

Step 1: Click on the device and pull down to the Tools menu bar.

Step 2: Pull over toReal-Time Graphs.

The Real-Time Graphs window appears. See Figure 4-8.

1If a button is grayed out, the selected device does not have this capability. For example, currently only a Cisco AGS+
with firmware 2.0 has the Environment router health button capability.

Component Subcomponent Description

File Print
Version

Quit

Prints a snapshot of the window.
Displays the CiscoWorks application version
information.
Exits the current window.

Option Set Polling
Frequency

Changes polling rate.Frequency of analysis
performance in seconds. Can be set using
slider or typing in on the polling interval
field. Default = 2 seconds.

Help Provides a manual page on the current win-
dow.

Polling
Frequency

Polling Interval
Slider

Changes the polling rate by clicking on the
slider.

Router Health

Interface Health

Protocol Traffic1

Refer to Table 4-5 for detailed descriptions of
the router health buttons.
Refer to Table 4-6 for detailed descriptions of
the interface health buttons.
Refer to Table 4-7 for detailed descriptions of
the protocol traffic buttons.
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Note: The device namedpag.cisco.comwhose Real-Time Graphs window appears in
Figure 4-8 does not have the following protocols activated on this router: DECnet IV,
Novell, VINES, and XNS. CiscoWorks indicates inactive buttons on its application
windows by graying the buttons out.

Table 4-5 Router Health Buttons

Note: To customize your current graph, refer to yourSunNet Manager 2.0 User’s Guide
for detailed information. The Grapher is an SNM feature and is not covered within this
manual.

Step 3: To gather data on interface health, click on the appropriate button. Table 4-6
describes the buttons and MIB object descriptions that are polled when you
press the button.

Note: To gather data on router health, click on one of the button choices for data.
Table 4-5 describes the buttons and MIB object descriptions that are polled when you press
the button. Refer to theCisco MIB User Quick Referencefor a description of MIB objects.

Buttons Description MIB Object Names

Buffer Space Displays the following buffer ele-
ments: number of free buffers, maxi-
mum number, hits, misses, creates,
buffer allocation failures, and buffer
create failures due to no free memory.

bufferElFree
bufferElMax
bufferElHit
bufferElMiss
bufferElCreate
bufferFail
bufferNoMem

CPU Load Displays CPU busy percentage for
one- and five-minute averages and for
the last five-second period.

avgBusy1
avgBusy5
busyPer

Environment Displays AGS+ router internal temper-
ature and airflow statistics.

envInternalTemperature
(envTestPt1Measure)
envAirflowTemperature
(envTestPt2Measure)

Free Memory Displays the amount of free memory in
bytes.

freeMem

Security Displays the total number of packets
dropped due to access control failures.

ipNoaccess
For DECnet,
dnNoaccess
For AppleTalk,
atNoaccess
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Table 4-6 Interface Health Buttons

Buttons Description MIB Object Names

Bits/Sec Displays the five-minute average of
input and output bits per second for
Cisco-specific devices.

locIfInBitsSec
locIfOutBitsSec

Bytes Displays the five-minute average of
input and output bits per second. For
routers with Software Release 9.1, dis-
plays all protocols on an interface.

ifInOctets
ifOutOctets

Errors ForCisco-specific devices, displays
number of input packets with various
characteristics.

For Ethernet, 802.3
CSMA/CD, starLAN:
locIfCollisions
locIfInRunts
locIfInGiants
locIfInCRC
locIfResets
locIfRestarts

For FDDI and Token
Ring:
locIfInRunts
locIfInGiants
locIfInCRC
locIfResets
locIfRestarts

For serial (Cisco only):
locIfInFrame
locIfInOverrun
locIfInIgnored
locIfInAbort
locIfResets
locIfRestarts
locIfCarTrans

For anynon-Cisco devices, displays
number of input and output errors with
various characteristics on an interface.

ifInErrors
ifOutErrors

Packets/Sec Displays the five minute average of
input and output packets per second on
an interface.

locIfInPktsSec
locIfOutPktsSec

Packets For any device, displays the input and
output packets on an interface. For rout-
ers with Software Release 9.1, displays
all protocols on an interface.

ifInNUcastPkts
ifOutNUcastPkts
ifInUcastPkts
ifOutUcastPkts

Queue For any Cisco device, displays the num-
ber of packets dropped because the
input or output queue was full.

locIfInputQueueDrops
locIfOutputQueueDrops
ifOutQLen (non-Cisco
devices)
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Step 4: To gather data on protocols, click on the appropriate button. Table 4-7 describes
the buttons and MIB object descriptions that are polled when you press the
button.

The real-time graphs you create will use the polling frequency that appears in
the window. You can enter a new polling frequency.

Table 4-7 Protocol Traffic Buttons

Button Description MIB Object Names

AppleTalk Displays cumulative AppleTalk
packet activity.

atInput
atOutput
atForward
atLocal
atBcastin
atBcastout
atNoencap
atInmult

IP Displays cumulative IP packet
activity.

ipForwDatagrams
ipInDelivers
ipInReceives
ipOutRequests
ipInDiscards
ipOutDiscards
ipOutNoRoutes

ICMP Displays cumulative ICMP activity. icmpInMsgs
icmpOutMsgs
icmpInErrors
icmpOutErrors
icmpInEchos
icmpOutEchos
icmpInEchoReps
icmpOutEchoReps

SNMP Displays cumulative SNMP packet
activity.

snmpInTotalReqVars
snmpInTotalSetVars
snmpInTraps
snmpOutTraps
snmpInPkts
snmpOutPkts
snmpOutGetResponses
snmpOutSetRequests

TCP Displays cumulative TCP packet
activity.

tcpActiveOpens
tcpPassiveOpens
tcpAttemptFails
tcpEstabResets
tcpInSegs
tcpOutSegs
tcpRetransSegs



Performance Management■ 4-27

Step 5: After you click on a button, a Grapher window appears.

Figure 4-9 displays the real-time graph for buffer space.

UDP Displays cumulative UDP packet
activity.

udpInDatagrams
udpOutDatagrams
udpInErrors
udpNoPorts

DECnet IV Displays cumulative DECnet IV
packet activity.

dnForward
dnReceived
dnHellos
dnHellosent
dnDatas
dnNoroute
dnToomanyhops

Novell Displays cumulative Novell packet
activity.

novellInput
novellOutput
novellForward
novellLocal
novellBcastin
novellBcastout
novellNoroute
novellNoencap

VINES Displays cumulative VINES
packet activity.

vinesInput
vinesOutput
vinesForwarded
vinesLocaldest
vinesBcastin
vinesBcastout
vinesBcastfwd
vinesNoroute
vinesEncapsfailed

XNS Displays cumulative XNS packet
activity.

xnsInput
xnsForward
xnsLocal
xnsBcastin
xnsBcastout
xnsErrin
xnsErrout

Button Description MIB Object Names
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Figure 4-9 Real-Time Graphs Window for Buffer Space Statistics

Seconds later a Results Grapher window also appears, but is hidden behind the
grapher window. The devices and objects you selected appear in the scroller
window. See Figure 4-10.

Figure 4-10 Results Grapher Window
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Viewing or Changing Graph Properties
The Real-Time Graphs application uses SNM’s graphing utility. If you want to change the
appearance of your real-time graph, you need to use SNM’s Results Grapher window. The
following tasks can be performed using the Results Grapher:

■ View different graphs listed in the Results Grapher browser.

■ Change graph properties, such as color, plot values, and scaling parameters.

■ Remove or halt real-time graphs data collection.

■ Merge two or more graphs.

Refer to theSunNet Manager 2.0 User’s Guide for more information on the SNM grapher.

Using the Path Tool
The Path Tool application enables you to monitor the performance of your routing protocols
by displaying the routing path between a source device and a destination device using
standard SNMP or IP.

This application is described in the “Fault Management” chapter

When using the Path Tool for performance management vary your severity thresholds over
a period of time and monitor the changes accordingly so you can collect baseline data.

A black link in a path displayed in the Path Tool window indicates that the device did not respond to
SNMP.

Using Show Commands to View Router Data
You can use the Show Commands to monitor system status, IP information, and traffic
information. This information helps you to determine how to change and improve your the
efficiency of your network environment.

Refer to theRouter Products Configuration and Reference publication for more detailed
descriptions of allshow commands; refer to Volume 1 for all but protocol-specificshow
traffic  commands andshow commands.

Refer to Chapter 3 for detailed information on the Show Command window components.

To use the Show Commands application, perform the following steps:

Step 1: Click on a network device. Use a Cisco router or communication server if you
have one.

Step 2: While you are clicking over the device, pull down the device or Glyph menu to
Tools. Continue to pull the Tools menu to the right to show the next level menu
display and selectShow Commands.
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Figure 4-11 illustrates the Show Command window that appears.

Figure 4-11 Show Commands Window

Step 3: To request specific system status, IP information, or traffic information, click on
the desired Show Command button.

Each show window is described in detail in “Using Show Commands to View
Router Data,” in Chapter 3.

Step 4: To exit this window, select the File menu and pull down toQuit .

Note: Show command information provided using the CiscoWorks software differs
slightly from the show command performed directly at the router console. The difference
in statistics may occur if information is not available through the SNMP protocol.

Writing Reports with the Sybase Data Workbench (DWB)
The CiscoWorks Sybase DWBapplication allows you to access the Sybase Data
Workbench (DWB) utilities. While Sybase DWB provides several applications, this section
only describes how to use the report-writing application in DWB.

There are two ways to access Sybase DWB: through the SNM Tools menu or through the
command line. The steps to access Sybase DWB are described in the following sections.
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Note: The CiscoWorks system administrator should immediately change the default to a
password appropriate to your operation using the instructions contained in theSybase
System Administration Guide. Refer to the Sybase manual set for more information on the
Data Workbench application. TheSybase Data Workbench User’s Guide explains the DWB
application. TheSybase Report Workbench User’s Guide explains the report writer accesses
through DWB.

For complete information on the Sybase DWB applications, refer to the Sybase manuals
listed in the front matter. For an online manual page, entersyman dwb. Sybase contains a
documentation directory that has several helpful files called$SYBASE/doc.

Invoking Sybase DWB from the Tools Menu
To invoke the Sybase DWB application from the SNM Tools menu, perform the following
steps:

Step 1: Select the Tools menu on the SNM console and pull down toSybase DWB.

The Sybase Data Workbench Login window appears. See Figure 4-12.

Figure 4-12 Sybase Data Workbench Login Window

Use the usernameuser to log in. Press Return to enter the default password.

If your password entry is incorrect, the system will intercept you with a confir-
mation window. To close the window, press Return. Retry your password entry.

Step 2: If you decide not to proceed with reentry into Data Workbench, click on the
DWB window menu icon in the upper left corner of the window.

If your password entry is correct, you are immediately transferred to the DWB
main window. See Figure 4-13.
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Figure 4-13 Sybase Data Workbench

Note: If you want to exit any window in Data Workbench, click on the DWB window
menu icon. Pull down and continue to pull over theClose command, or click outside of the
menu.

Invoking Sybase DWB from the Command Line
Before running this application from the command line, you need to alter your terminal
environment variable. We recommend that you access the application through the SNM
Tools menu because it alters the variable automatically. If you need to use the command
line, follow these steps:

Step 1: To display the current terminal environment, enter the following at the
command line:

% echo $TERM

Make a note of your terminal default. Type this variable in when you finish
using Sybase DWB to return your terminal to use other CiscoWorks applica-
tions.

Step 2: To set your terminal variable to run using your Sun workstation, enter the
following at the command line:

% set term=xterm_c.sun

Step 3: At the command line, enter the following:

% cd $NMSROOT/sybase/bin

Step 4: Then enter the Sybase DWB command:

% dwb

The DWB Login window appears. See Figure 4-12.
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Step 5: Use the usernameuser to log in. Press Return to enter the default password.

Step 6: Continue with “Using Report Writing” later in this chapter for detailed
instructions on how to use this application.

Step 7: When you have finished using DWB from the command line, reset your terminal
default to its original state. Enter the following and press Return:

% set term=original term setting

Using Report Writing
The Reports menu on the Sybase Data Workbench window enables you to run and print a
report on any table created with theDevice Pollingapplication.

The following are two examples of how to use the report-writing feature:

■ Visual query language (VQL)

VQL is a visually oriented front-end to SQL. VQL relies on menus and a point-and-
select method to create the equivalent SQL.

■ Structured query language (SQL)

An industry-standard database query language, SQL is commonly used with most well-
known databases.

Running a Sample Report with VQL
This section describes how to run sample reports that are available in the CiscoWorks
database.

There are three sample reports in the CiscoWorks database:devices, totals, and utilization.
These reports correlate to the Sybase polling table named sample.

A brief description of the sample reports appear below:

■ devices–Reports what network devices are in the database.

■ totals–Calculates totals for numbers of packets, errors, broadcasts, maximum traffic,
and uptime for each device.

■ utilization–Calculates link utilization for each device interface.

To run the sample reports, perform the following steps:

Step 1: Access Sybase DWB from the Tools menu as described in the section, “Invoking
Sybase DWB from the Tools Menu,” earlier in this chapter.

Step 2: In the main window of DWB, select the Reports menu and pull down to the
Existing command. See Figure 4-14.
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Figure 4-14 Sybase Data Workbench—Reports Menu

Step 3: Three reports appear:devices, totals, andutilization. Select one of the reports.

Step 4: Select the Actions menu and pull down toRun.

The Standard Report Parameters window appears. See Figure 4-15.

Figure 4-15 Sybase Data Workbench—Standard Report Parameters Window

Step 5: Accept the default settings to run the report to the display. Click on the DWB
window menu icon and select theClose option and pull over toApply.

A report similar to the one in Figure 4-16 appears on your screen.
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Figure 4-16 Sybase Data Workbench—Standard Report

Creating a New Report with VQL
This section describes how to create a new report. To create a new report, define the report
you want to run and then format it. You perform this process within theDevice Polling and
Polling Summary applications. You then need to run a script file that substitutes MIB
object names for current column names such as var1 and var2.

The following examples use the default VQL layout. Refer to the Sybase Data Workbench
User’s Guidefor details on how to customize the format of your reports.

To create a new report, complete the following steps:

Step 1: Define the report in the Polling Summary application.

Refer to “Creating Polling Tables Using Device Polling” for information on
setting your polling tables and “Using Polling Summary” for information on
performing polling.

Step 2: To check that your SYBASE environment variable is set correctly, enter the
following at the command line:

hostname% printenv SYBASE

The system should respond with the location of SYBASE on your system,
typically /usr/sybase.

Step 3: To run thegenmibview script, enter the following at the command line:

hostname% cd $NMSROOT/etc
hostname% genmibview -Uuser -P tablename

Thegenmibview script creates separate tables that contain the MIB variable
names instead of variable names such as var1, var2, and so on. The new table
name will append_view to the original table name. For example, if the table
name istraffic, the new table is calledtraffic_view.

Step 4: Select the Reports menu and pull down to theNewcommand. See Figure 4-14.

The SQL Batch Editor window appears. See Figure 4-17.
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Figure 4-17 SQL Batch Editor Window

Step 5: Select the VQL! menu.

Step 6: Select the Use menu and pull down to theTable command.

The Use Table window appears over the center of the VQL window.

Step 7: At theName prompt, enter the filename of the table that contains the variables
on which you would like to run a report.

Step 8: Click on the DWB window menu icon in the upper left corner, select theClose
option, and pull over toApply.

The contents of the table appear in the window.

Step 9: Select all of the data columns in the table. Select the Add menu and pull down
to theResult Columnscommand. See Figure 4-18.

Figure 4-18 Sybase Data Workbench—Results Columns Command
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Step 10: Select theSummary Valuescommand.

The Add Summary Values window appears.

Step 11:  Select the items to be averaged, then select the Function menu and pull down to
Average. See Figure 4-19.

Figure 4-19 Sybase Data Workbench—Add Summary Values Window

Step 12: Click on the DWB window menu icon in the upper left corner and select the
Close option to exit again.

The SQL Batch Editor displays.

Step 13: At theNameprompt, enter a name to identify your SQL batch statement. Click
on the DWB window menu icon in the upper left corner and select theApply
command under the Close option. See Figure 4-20.

The Report Workbench window appears.

Figure 4-20 Sybase Data Workbench—SQL Batch Editor



4-38■ CiscoWorks User Guide

Step 14: Select the Report menu and pull down to Processing.

Ensure the filename is entered at the Process prompt.

Step 15: Select the Compile menu. Click on the DWB window menu icon in the upper
left corner and select theApply command under the Close option. See
Figure 4-21.

Figure 4-21 Sybase Data Workbench—Compile Menu

Step 16: Select the Report menu and pull down toRun.

The Standard Report Parameters window appears.

Step 17: Accept the default settings to run the report to the display.

Step 18: Click on the DWB window menu icon in the upper left corner and select the
Apply command under the Close option.

A report similar to the one in Figure 4-22 appears on your screen.

Figure 4-22 Sybase Data Workbench—Standard Report
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Step 19: To save the report, select the Report menu and pull down toSave.
See Figure 4-23.

Figure 4-23 Sybase Data Workbench—Saving the Report

Step 20: At the Save edited report as: prompt, enter the name of the report.

Step 21: Click on the DWB window menu icon in the upper left corner and select the
Apply command under the Close option. Then click onExit Report
Workbench and press Return.

Running a Sample Report with SQL
Presented in this section are several SQL report-writing examples. Using these examples,
you can construct your custom reports, print them on a printer or view them on the screen.

A data field contains a single item of information such as device name, device type, or postal
code. Related columns of data fields are collected into tables. These collections of related
information are arranged in records that relate to entities such as addresses, names, device
names, and so on. These horizontal collections of records are also called rows. If you were
to look at a database you would see all fields in columns and all records in rows.

For instance, the following columns are in the locations table:

■ address_id

■ location

■ street

■ street_two

■ city

■ state

■ country

■ zip_code
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Static Table Queries
You can create reports using columns of data in the static database. For example, to create
a quick report on devices of a certain type including type, name, and serial number, enter
the following poll in the SQL parameter window:

select device_id, device_type, device_name, serial_number from
devices where device_type = 0

Run the poll by selectingSybase DWB. Select the SQL option from the Queries menu.
When the SQL window appears, you can type the poll directly into the window, or read it
in from a file.

To read a file into the window, selectRecall Command and thenFrom Host File. You will
be prompted for the name of the file in which you have stored the poll.

Regardless of how you enter the poll, process it by selectingRun Command. You can
display the results on screen, send them to a printer, or store them in a file. While you are
experimenting, a screen display is usually most convenient.

Once the results come back, you can use the Format option. To format each column of your
report. Refer to theSybase Data Workbench User’s Guide for detailed information. While
in the display, you can scroll back and forth or up and down among the results.

If you want to produce hardcopy reports with pagination, headers, and footers rather than
just columns of text, use Report Workbench to format the report. The Report Workbench
will take your running poll and allow you to lay out the results for output to a printer using
a WYSIWYG editor. If you have successfully run a poll and specified the set of data you
are interested in, exit the Display Window (click the X icon) and then exit the SQL editor.

Choose the Reports menu item. It will display a submenu with two items: New and
Existing. Choose New. This opens the SQL Batch Editor of the Report Workbench. Name
the file in which you stored the poll and bring up the default report.

Refer to theSybase Data Workbench User’s Guide for a description of how to format your
results for output to the printer.

These examples show a simple version of the results assume in an online poll in DWB:

device_id device_type device_name serial_number
5 0drossNULL

Often, data you want is distributed across multiple tables. If you want to know more about
the device type than just its number, you can include a description in your report by
combining data from the devices and device_types tables. This means you name both tables
in your FROM clause. You expand the WHERE clause to find only the relevant type
description by linking (the technical term is “joining”) the two tables on their shared
columns.

The poll to do this would be:

select device_id, devices.device_type, device_name, device_types.
type_desc from devices, device_types where device_id = 5 and
devices.device_type = device_types.device_type
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Notice that a full name in tablename.columnname format is required whenever a column
name is not unique in a poll. The results would look something like this, depending on how
you formatted them:

device_id device_type device_name type_descr
5 0drossdefault

You can have as many tables as you want, a poll (and results) drawing data from three tables
could look like this:

select device_name, device_types.type_desc, vendor_name
from devices, device_types, vendors
where device_type =0
and devices.device_type = device_types.device_type
and devices.vendor_id = vendors.vendor_id
device_name type_descr vendor_name
dross defaultdefault

Running Custom Table Queries
You can also use columns from static tables in conjunction with columns from custom
tables you create. These custom tables include real-time data for the MIB variables you
select. The following example illustrates what you can do once you get started. No two
networks are alike and the type of diagnostic or accounting information you might find
interesting is specific to your environment.

These examples are included only as a starting point for your own experimentation. Assume
you need information about device utilization levels and uptime percent. Using Device
Polling, Polling Summary, and Sybase DWB, you could produce this report:

For the period From: Mar 27 1992  5:44PM   To: Mar 28 1992  11:59AM
Device          Interface Pct Util
 --------------- --------------- --------------------
 abc            Ethernet0                  83.607993
 abc            Ethernet1                  75.815578
 abc            Ethernet10                 36.269430
 abc            Ethernet11                 83.352942
 abc            Ethernet12                 36.269430
 abc            Ethernet13                 36.269430
 abc            Ethernet14                 72.564532
 abc            Ethernet15                 82.645540
 abc            Ethernet2                  74.855613
 abc            Ethernet3                  97.716789

To obtain these results, use polling tables to collect information from the network and store
it in the database. Then use SQL queries to display data from the database.

In the example that follows, the device is 5, the interfaces are 5, 11, and 12, and the MIB
variables are:ifInOctets, ifOutOctets, and ifSpeed.The polling interval is 10 minutes. The
name of the new table isdevice_usage.

The text of the poll that creates this report is as follows:

/*** Report of % Utilization, % Uptime by Device and Interface*/
SELECT device_id, SUM(sysUpTime)/100 uptime into #t4
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FROM sample_view
WHERE rec_type = 0
GROUP BY device_id
go

select distinct device_id, convert(int, inst) inst into #t1
from sample_view
where rec_type = 0
order by device_id, convert(int, inst)
go

select #t4.device_id, inst, uptime into #t2
from #t1, #t4
where #t1.device_id = #t4.device_id
order by #t1.device_id, inst
go

select device_id, convert(int, inst) inst, sum(ifInOctets) ifInOctets,
sum(ifOut
Octets) ifOutOctets, max(ifSpeed) ifSpeed
into #t3
from sample_view
where rec_type = 0
group by device_id, convert(int, inst)
order by device_id, convert(int, inst)
go

select substring(device_name, 1, 15) Device, substring(interface_name,
1, 15) Interface,100 * convert(f loat, (ifInOctets + ifOutOctets))/ con-
vert(float, (uptime))/convert(float, (ifSpeed/8)) "Pct Util"
from #t3, #t2, devices, interfaces
where #t3.device_id = #t2.device_id
and #t3.device_id = devices.device_id
and #t3.inst = interfaces.interface_id
and #t3.device_id = interfaces.device_id
and #t3.inst = #t2.inst
order by substring(device_name, 1, 15), substring(interface_name, 1,
15)
go

drop table #t4
go

drop table #t1
go

drop table #t2
go

drop table #t3
go
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Improving Report Format
You can improve the appearance of the output from your queries. Simple changes can be
made with the Format option after you run a poll from the Data Workbench. More complex
changes in the appearance of the output can be achieved using the Report Writer. You can
also save your queries and reports and run them later from UNIX without using Data
Workbench.

When you run the poll and display the results on the Data Workbench, the Format menu
item lets you change the appearance of the results. The following are some of the things you
can change:

■ Column width

■ Column headings

■ Data alignment

■ Column display order

The Format option is explained in more detail in theSybase Data Workbench User’s Guide.
For hardcopy reports, make any additional changes with Report Writer.

Writing SQL Reports for Custom Polling Tables
To write SQL-based reports for analyzing data collected in polling tables, you must be
familiar with CiscoWorks polling applications, Simple Network Management Protocol
(SNMP), and structured query language (SQL).

Table 4-8 shows the columns that are always present in a polling table. The remaining
columns are user-defined and contain the values of the polled MIB objects.

Table 4-8 Columns in a Polling Table

If the polled MIB objects are indexed byifIndex, the inst column contains the appropriate
value (for example,ifIndex or locIfxxx). This inst column can be used to join with the
interface_id column in the Interfaces table. To join the inst column with the interface_id
column, add the following to the SQL WHERE clause:

select ...
where ...
and convert(int, inst) = interfaces.interface_id

Field Name Field Size Field Type

timestamp datetime Timestamp for each row of data polled

device_id int Join to devices table

sysUpTime int System up time in 100ths of a second

inst char (255) Index into MIB object table

rec_type tinyint 0 = normal record, 1 = start record, 2 = not
used, 3 = restart record, 4= irregular records
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When you start polling a device, CiscoWorks creates a record with rec_type = 1. All the
values in this record are absolute. All other records have rec_type = 0 and contain a mix of
delta and absolute values. When you stop polling a device, you do not get any additional
rows. A new rec_type value of 4 has been added to account for any anomalies or
irregularities, which includes absolute values instead of delta values.

You can determine whether a MIB object will contain an absolute or delta value by getting
its data type from the$SNMHOME/agents/cisco.schema file and identifying the value for
each type. For example, sysUpTime uses timeticks as its record type, so the data value will
be displayed as a delta value (the difference in value between the current poll and the last
poll) if rec_type = 0.

For information on identifying the value for a data type, refer to Table 4-9.

Table 4-9 Values for Types of Records

Specifying MIB Object Values
When you create a polling table in Device Polling, you specify the MIB object values that
you want to collect. These values are collected by the poller and added to the database as
the values are received. When polled values arrive at the poller in different packets, the
values are written to the database in different records. Therefore, you might find that the
data for a given poll is spread over two or more records, with NULL appearing where data
was not available.

The following example shows how polling data is received over time and added to the
database:

Polling:
                time    sysUpTime       var1    var2    inst
                 x         100           10               1
                 x+1       101                   15       1
                 x+2       102           10               2
                 x+10      110           20               1
                 x+11      111           25               2
Database storage:
                rec_type sysUpTime      var1    var2    inst

1 100 10 1
1 101 15 1
1 102 10 2
0  8 10  1
0  1 15 2

Record
Type Value

timeticks delta

counter delta

gauge absolute

int absolute
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You cannot perform row operations without first grouping and aggregating your data. You
might want to use the timestamp column to perform groupings and then use the AVG or
MAX (for absolute values) or SUM (for delta values) to aggregate. You can use the
following GROUP BY clause to group by device, inst, and 15-minute intervals:

select ...
group by device_id, convert(int, inst), datepart(dd, timestamp),
datepart(hh, timestamp), convert(int, datepart(mi, timestamp)/15)

Using genmibview
In a custom polling table, the columns containing the polled object values are labeled
var[1-n], wheren is the number of polled MIB objects. Thegenmibview script in the
$NMSROOT/etc directory enables you to create a view of the polling table that uses the
MIB variable names. Use the following command to create a table with meaningful column
names:

$NMSROOT/etc/genmibview -U user -P password tablename

The command creates a view calledtablename_view. For example, to generate a view for
a polling table namedtraffic, a user namednetman and a password cisco, use the following
command:

$NMSROOT/etc/genmibview -U netman - Pcisco traffic

This command creates a view of the traffic table calledtraffic_view, with columns named
after the MIB object names.

Computing sysUpTime Over a Polling Interval
To calculate time-dependent statistics for a device, calculate the total device uptime during
the polling period. Create a temporary table containing the uptime for each polled device by
using the following SQL commands:

select device_id, sum(sysUpTime)/100 uptime into #t1 from <table>
where rec_type = 0 group by device_id

The SQL commands create a temporary table called#t1 that contains device IDs and the
uptime values for each device. The value is divided by 100 so that uptime will be in seconds
(sysUpTime is in 100ths of a second).

Using ifOperStatus and ifAdminStatus
If you are polling interface values, includeifOperStatus andifAdminStatus in your polling
values to determine whether a given interface is operational. If you are using a GROUP BY
clause in your SQL, add a HAVING condition to the group to check whether the interface
was operational. Add the following commands to the group:

select ...
group by ...
having max(ifOperStatus) = 1 and max(ifAdminStatus) = 1
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The possible values forifAdminStatus are listed in Table 4-10.

Table 4-10 Values for ifAdminStatus

These values are also described in RFC 1213,Management Information Base for Network
Management of TCP/IP-based Internets: MIB-II.

Using Report Writer to Present Your Data
Once you have written and saved your poll, you can focus on the presentation of data on
the printed page. Under the Reports option of the Data Workbench, chooseDefine and then
selectSetup. Under Setup, selectQueries, and under Queries, selectSQL. The poll you
run appears in the window.

In the window, you can recall queries from files and save them to files. When you use the
Run Report command, you see a layout of all the elements of the report. You can edit the
page layout and the data display, add trim, and change control break processing of the data.
Run Report allows you to see the default layout on screen.

The poll will collect the set of data to be reported and the report writer will format the
current set of data in the way you describe. When you exit from the Reports window, you
will be notified to save your report in the database. Give the report a name and confirm your
exit from the report menu.

For complete information about Report, refer to theSybase Data Workbench User’s Guide.

Running Reports from UNIX
You can run reports created and saved by the Data Workbench from the UNIX command
line with therunrw  command. The output of the report is automatically sent to your default
printer.For more information aboutrunrw , see the appropriate UNIX command reference
manual furnished with your system.

The following is the command syntax for the sample report calledstorm_report:

runrw storm_report -Uyourname -Ppassword

To run a report owned by another user, enter the following at the command prompt:

hostname% runrw  user name.devicerpt -Uyourname -Ppassword

Value Meaning

1 up

2 down

3 testing


